Copyright Information

Copyright © 2019 Aras Corporation. All Rights Reserved.

Aras Corporation
100 Brickstone Square
Suite 100
Andover, MA 01810

Phone: 978-806-9400
Fax: 978-794-9826

E-mail: Support@aras.com
Website: https://www.aras.com

Notice of Rights
Copyright © 2019 by Aras Corporation. This material may be distributed only subject to the terms and conditions set forth in the Open Publication License, V1.0 or later (the latest version is presently available at http://www.opencontent.org/openpub/).

Distribution of substantively modified versions of this document is prohibited without the explicit permission of the copyright holder.

Distribution of the work or derivative of the work in any standard (paper) book form for commercial purposes is prohibited unless prior permission is obtained from the copyright holder.

Aras Innovator, Aras, and the Aras Corp "A" logo are registered trademarks of Aras Corporation in the United States and other countries.

All other trademarks referenced herein are the property of their respective owners.

Notice of Liability
The information contained in this document is distributed on an "As Is" basis, without warranty of any kind, express or implied, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose or a warranty of non-infringement. Aras shall have no liability to any person or entity with respect to any loss or damage caused or alleged to be caused directly or indirectly by the information contained in this document or by the software or hardware products described herein.
# Table of Contents

Send Us Your Comments ........................................................................................................... 5
Document Conventions .................................................................................................................. 6

1 Introduction .................................................................................................................................. 7

2 Installing Reporting Services ....................................................................................................... 8
   2.1 Installation is a component of SQL Server 2016 ......................................................................... 8
      2.1.1 Default Instance ..................................................................................................................... 9
      2.1.2 Service account Setup .......................................................................................................... 10
      2.1.3 Database Engine Configuration and Authentication Mode .................................................. 11
      2.1.4 Analysis Services Configuration ............................................................................................ 12
      2.1.5 Reporting Services Options .................................................................................................. 13
      2.1.6 Remaining Selections ............................................................................................................ 13

3 Configuring Reporting Services .................................................................................................... 14
   3.1 Installing Reporting Services ..................................................................................................... 14
   3.2 Setting Up the Report Folder ..................................................................................................... 16
   3.3 Adding a Shared Data Source ..................................................................................................... 18
   3.4 Adding Reporting Services User and Role .................................................................................. 21
      3.4.1 Add local User Account for Reporting .................................................................................. 21
      3.4.2 Add the Reporting Role ....................................................................................................... 21

4 Using Visual Studio for Report Design .......................................................................................... 27
   4.1 Create a New Report Project ....................................................................................................... 27
   4.2 Configure Project Properties ..................................................................................................... 28
   4.3 Add New Shared Data Source .................................................................................................... 28
      4.3.1 Connection Properties ......................................................................................................... 28
      4.3.2 Deploy the Shared Data Source ............................................................................................ 30

5 Creating your First Report ............................................................................................................. 31
   5.1 Start a New Report using the Wizard .......................................................................................... 31
   5.2 Select the Data Source .............................................................................................................. 32
   5.3 Design the Query ....................................................................................................................... 33
   5.4 Select the Report Type .............................................................................................................. 34
   5.5 Design the Table ....................................................................................................................... 35
   5.6 Choose the Table Style .............................................................................................................. 36
   5.7 Name the Report ....................................................................................................................... 37
   5.8 Wizard Report Results .............................................................................................................. 38
   5.9 Visual Studio Layout .................................................................................................................. 38
   5.10 Deploying the Report .............................................................................................................. 39
   5.11 Confirm Deployment ................................................................................................................. 39
   5.12 Running the Report from within Aras Innovator ..................................................................... 40
      5.12.1 Adding Aras Innovator Report Item .................................................................................... 40
5.12.2   Passing Named Parameters to the ReportServer ................................................ 41

6   Report Server query_string Parameters .................................................................. 43

   6.1   Named Parameters ......................................................................................... 43
   6.2   Format Parameter ......................................................................................... 43
   6.3   Zoom ............................................................................................................ 43
   6.4   Reports Folder ............................................................................................... 43
   6.5   Report Name .................................................................................................. 43

7   Report Manager ...................................................................................................... 44

   7.1   Opening the Report Manager page ................................................................. 44
   7.2   Export the RDL .............................................................................................. 45
   7.3   Import the RDL .............................................................................................. 46
   7.4   Select the Shared Data Source ....................................................................... 49

8   Date Related SQL Queries ...................................................................................... 51
Send Us Your Comments

Aras Corporation welcomes your comments and suggestions on the quality and usefulness of this document. Your input is an important part of the information used for future revisions.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where and what level of detail?
- Are the examples correct? Do you need more examples?
- What features did you like most?

If you find any errors or have any other suggestions for improvement, indicate the document title, and the chapter, section, and page number (if available).

You can send comments to us in the following ways:

Email:
Support@aras.com
Subject: Aras Innovator Documentation

Or,

Postal service:
Aras Corporation
100 Brickstone Square
Suite 100
Andover, MA 01810
Attention: Aras Innovator Documentation

Or,

FAX:
978-794-9826
Attn: Aras Innovator Documentation

If you would like a reply, provide your name, email address, address, and telephone number.

If you have usage issues with the software, visit https://www.aras.com/support/
## Document Conventions

The following table highlights the document conventions used in the document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>This shows the names of menu items, dialog boxes, dialog box elements, and commands. Example: Click <strong>OK</strong>.</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Code examples appear in <em>courier</em> text. It may represent text you type or data you read.</td>
</tr>
<tr>
<td><strong>Yellow highlight</strong></td>
<td>Code with yellow highlight is used to draw attention to the code that is being indicated in the content.</td>
</tr>
<tr>
<td><strong>Yellow highlight with red text</strong></td>
<td>Red color text with yellow highlight is used to indicate the code parameter that needs to be changed or replaced.</td>
</tr>
<tr>
<td><strong>Italics</strong></td>
<td>Reference to other documents.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Notes contain additional useful information.</td>
</tr>
<tr>
<td><strong>Warning</strong></td>
<td>Warning contains important information. Pay special attention to information highlighted this way.</td>
</tr>
<tr>
<td><strong>Successive menu choices</strong></td>
<td>Successive menu choices may appear with a greater than sign (--&gt;) between the items that you will select consecutively. Example: Navigate to <strong>File --&gt; Save --&gt; OK</strong>.</td>
</tr>
</tbody>
</table>
1 Introduction

Aras Innovator’s Report ItemType includes support for Microsoft’s ‘Reporting Services’ in addition to supporting the existing XSLT based reports.

Reporting Services is an integral component of SQL Server 2016, and any customer with a SQL Server 2016 license can install Reporting Services. (See installation instructions below).

Usage of this release is recommended only for those with advanced Aras Innovator and SQL training.

Primary benefits to switching from stylesheet driven reports to Report Server:

- Query building is in SQL, and is graphical (same as in Enterprise Manager).
- Report definitions are transportable, you can develop on your laptop, and then deploy to a production server.
- Report layout is more drag-n-drop and has more powerful formatting tools.
- The resulting reports are paginated.
- The end-user can easily print, PDF, or export to Excel the report output.
- Excel like Charts and graphs can be produced

Planned enhancements are a tighter integration of the authentication / permissions model, and finding an alternative to Visual Studio for end-use report layout.

To learn more about Microsoft Reporting Services visit: Microsoft SQL Server: Reporting
2 Installing Reporting Services

Reporting Services is a component of Microsoft SQL server 2016 and can be installed by selecting the ‘Reporting Services’ option during the SQL server installation.

In addition to selecting the Reporting Services option, you can select ‘Analysis Services’ which provides graphing and charting functionality.

2.1 Installation is a component of SQL Server 2016

The following is a summary of dialogs to be used when installing SQL server 2016.

**Note:** If you view dialog boxes not listed here, use the default selections.
2.1.1 Default Instance

Figure 2.
2.1.2 Service account Setup

Figure 3.
2.1.3 Database Engine Configuration and Authentication Mode

Figure 4.
2.1.4 Analysis Services Configuration

Figure 5.
## 2.1.5 Reporting Services Options

### Reporting Services Configuration

Specify the Reporting Services configuration mode.

<table>
<thead>
<tr>
<th>Global Rules</th>
<th>Reporting Services Native Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Updates</td>
<td><strong>Install and configure.</strong> Installs and configures the report server in native mode. The report server is operational after setup completes.</td>
</tr>
<tr>
<td>Install Setup Files</td>
<td><strong>Install only.</strong> Installs the report server files. After installation, use Reporting Services Configuration Manager to configure the report server for native mode.</td>
</tr>
<tr>
<td>License Terms</td>
<td><strong>Reporting Services SharePoint Integrated Mode</strong></td>
</tr>
<tr>
<td>Feature Selection</td>
<td><strong>Install only.</strong> Installs the report server files. After installation, use SharePoint Central Administration to complete the configuration. Verify the SQL Server Reporting Services service is started and create at least one SQL Server Reporting Services service application. For more information, click Help.</td>
</tr>
<tr>
<td>Feature Rules</td>
<td>Instance Configuration</td>
</tr>
<tr>
<td>Instance Configuration</td>
<td>Server Configuration</td>
</tr>
<tr>
<td>Server Configuration</td>
<td>Database Engine Configuration</td>
</tr>
<tr>
<td>Database Engine Configuration</td>
<td>Reporting Services Configuration...</td>
</tr>
<tr>
<td>Reporting Services Configuration...</td>
<td>Feature Configuration Rules</td>
</tr>
<tr>
<td>Feature Configuration Rules</td>
<td>Installation Progress</td>
</tr>
<tr>
<td>Installation Progress</td>
<td>Complete</td>
</tr>
</tbody>
</table>

![Figure 6.](image)

## 2.1.6 Remaining Selections

The default selections can be used from this point forward.
3 Configuring Reporting Services

The Reporting Services use Folders to organize Reports. The Aras Innovator integration with Reporting Services uses as a default the Folder named ‘Innovator Reports’.

In this section, we configure the Reporting Services using the Report Manager by adding the ‘Innovator Reports’ Folder and a Shared Data Source, which the Reports use to connect to the database.

3.1 Installing Reporting Services

The Reporting Services ReportServer comes with a Report Manager page used to configure the Reports, Folders, Data Sources, and so on. This page has been integrated into Innovator client via an Innovator Report that opens the Report Manager page.

Open your browser with the URL http://localhost:80/Reports (on a default install).

To set up Reporting Services:

1. Open the Reporting Services Configuration Manager
2. Set up a Service Account

![Figure 7.](image-url)
3. Set up a Web Service URL

![Figure 8.](image1.png)

4. Set up the Database

![Figure 9.](image2.png)
5. Set up the Web Portal URL

![Figure 10.](image)

3.2 Setting Up the Report Folder

1. Open the **Report Manager** page (defined above) in a new window:
2. Click +, then **Folder**.
3. Enter ‘Innovator Reports’ for the name and click Create.

![Create a new folder in Home](image)

Figure 12.

**Note:** If you use a folder named something other than ‘Innovator Reports’, you need to change the ‘Report Server Folder’ variable in the database as well in Administration\Variables in the TOC. The default value for this is ‘Innovator Reports’ but can be customized for each database. For the purposes of these instructions, we assume the default value is used.

### 3.3 Adding a Shared Data Source

Once you add the ‘Innovator Reports’ Folder, navigate into it by clicking on the link. Now, you add a Shared Data Source for the Reports to use to connect to the database.

1. Click + then Data Source inside the Innovator Reports folder.
Figure 13.

The New Data Source dialog appears.
2. Enter **innovator_regular** for the Data Source Name.

   **Note:** By using the same name for both the development and production servers, exporting/importing Reports becomes simpler because there is no need to reassign the Data Source for the Reports you import.

3. Enter the following for the ‘Connection String’ replacing the values for the two parameters with the actual server name where SQL Server is installed as well as the actual database name.

   ```sql
   data source=<SQLServerName>;initial catalog=<InnovatorDatabase>
   e.g.
   data source=MyServer\MSSQLSERVER2016;initial catalog=InnovatorSolutions
   ```

4. Select the **Using the following credential** choice for the **Connect Using Field** and enter the **DB Client Login** credentials for your database.
5. Click **Create** to deploy the shared Data Source.

### 3.4 Adding Reporting Services User and Role

The entry point for the Microsoft Reporting Services is the ReportServer.asmx file. The same Web Service is used to request Reports and administer the Report Server. The Web Service is configured by default to use Windows Authentication. You can't simply open the security for anonymous Web users because that would open the Report Manager as well. This security model requires the User be authenticated when they request Reports. A dialog opens requesting the user's login credentials the first time they request a Report each time the browser is opened again. When requesting the Report from within Aras Innovator this would not be desirable. Users would not only have to constantly provide login credentials to access reports, but each Innovator user would also have to have either a domain or local user access on the server. To handle this problem, Aras provides the Innovator Reporting Services Gateway that processes requests to Reporting Services. This gateway uses one shared User Account for all Report requests. The Gateway submits the actual Report request using this shared User Account and propagates the results back to the client. The Report renders without the authentication dialog appearing. If the user attempts to view the Report directly outside Aras Innovator, they still see the authentication dialog as normal. So users can only view the Reports through Aras Innovator. The local User Account on the server by default is named 'Reporting' with a default password is 'reporting' and must be mapped as a Role in the Report Server.

#### 3.4.1 Add local User Account for Reporting

The administrator for the server where Microsoft Reporting Services is installed must add a new Windows User Account named 'Reporting'. Once the User Account is created you can configure Aras Innovator by setting the user name and password in the InnovatorServerConfig.xml configuration file:

```xml
<ReportingServices>
  <User_reporting><Password>reporting</Password>
  <Domain>Domain for the above User</Domain>
</ReportingServices>
```

Optional node, `<Domain>`, should contain the domain name you want to use to connect to Reporting services.

#### 3.4.2 Add the Reporting Role

The Reporting User Account must next be mapped as a Role in Reporting Services enabling this account Browser privileges.

1. Create a user on the Server named “Reporting”
2. Click on the **Site Settings** link in the upper right hand corner of the Report Manager page.
3. Click on the ‘Security’ tab.

Figure 15.

Figure 16.
4. Click ‘Add group or user’ to map the Reporting User Account as a Reporting Services Role.

![Figure 17.](image)

5. Enter the User Account name Reporting and check the System checkbox and click OK to create the new Role.
Figure 18.

6. Click on the **Browse** link in the upper left corner on the page
7. **Click on Manage Folder link**

![Figure 20.](image)
8. In the settings tab, click Add group or user.

Figure 21.

9. Enter Reporting in the Group or User field and check the Browser checkbox. Click OK to create a new Role Assignment for the Innovator Reports folder.

Figure 22.
4 Using Visual Studio for Report Design

Once the Reporting Services is installed you need to configure Visual Studio to create a Project to hold the Reports. Plus configure a Shared Data Source, which is the database connection information for the Reports.

**Note:** It is required that you follow the exact naming conventions as shown here to ensure that the Aras Innovator integration with the Reporting Services works correctly.

### 4.1 Create a New Report Project

Start [SQL Server Data Tools](https://www.microsoft.com/sql-server-data-tools) and create a new project named *Innovator Reports*. This becomes the Reporting Services Folder to hold the Reports for Aras Innovator.

![Figure 23](image)

![Figure 24](image)
4.2 Configure Project Properties

Open the ‘Solutions Explorer’ panel from the menu View → Solutions Explorer if it is not already opened.
Right-click the ‘Innovator Reports’ folder and select the Properties context menu choice.
On the Properties dialog set the TargetServerURL field to the URL of the Report Server. For example, http://localhost:80/ReportServer where the actual name of the server host name is entered in place of localhost.
Also set the OverwriteDateSources flag to True.

![Innovator Reports Property Pages]

Figure 25.

4.3 Add New Shared Data Source

In the same ‘Solutions Explorer’ panel, right-click on the ‘Shared Data Sources’ folder and select ‘Add New Data Source’ context menu choice. Click Edit to configure the new datasource.

4.3.1 Connection Properties

1. Select or enter the ‘Server name’ for the machine SQL Server is installed.
2. Select the ‘Use a specific user name and password’ option and enter the login credentials for the database and check the Save My password option.
3. Select or enter the ‘Database name’.
Figure 26.

Figure 27.
4.3.2 Deploy the Shared Data Source

By default, the name of the Shared Data Source is the name of the Database you selected above. You can rename this if you want. Finally, you need to deploy this new Shared Data Source.

Figure 28.
5 Creating your First Report

The following illustrates using the Report Wizard to create a new Report. For this Report we create a simple User Directory Report showing the Users First Name, Last Name, Email, Phone Number, and Company Name. The following is a screen shot of the Report that we will be creating:

5.1 Start a New Report using the Wizard

From the ‘Solution Explorer’ panel right mouse click on the ‘Reports’ folder and select the context menu choice ‘Add New Report’.

![Add New Report](image.png)

Figure 29.
5.2 Select the Data Source

You can create a unique Data Source for this Report but it typical that you use the default Shared Data Source that you created.

Figure 30.
5.3 Design the Query

You need to provide the SQL Select query that fetches the data for the Report. In many cases you can enter the simple select clause in the dialog directly.

![Design the Query dialog](image)

Figure 31.

**Note:** It is possible to pass Named Parameters into the query such as:

```sql
SELECT * FROM [PROJECT] WHERE id=@ID
```

The ‘Edit...’ button opens a Query Builder interface, which is covered later in more detail.
5.4 Select the Report Type

There are two choices for the Report Type: **Tabular** (column layout) and **Matrix** (rows and columns layout). Select the **Tabular** type:

![Select the Report Type](image)

Figure 32.
5.5 Design the Table

Select the fields that you want to show on the Report. In this case, we were selective about which fields to return from the query select clause so we want all the fields.

![Design the Table](image)

Figure 33.
5.6 Choose the Table Style

Select the style for the table for the Report. This example simply uses the default **State** style.

Figure 34.
5.7 Name the Report

The final step in the Report wizard is to name the Report.

**Note:** The **Report Name** must be chosen to be meaningful and should be the same name you set as the name of the Report Item in Aras Innovator.

Figure 35.
5.8 Wizard Report Results

The Report wizard builds the report, which looks similar to following screen shot:

![User Report](image)

Figure 36.

Once the Report is opened in the Layout Tab you can make further changes as required.

5.9 Visual Studio Layout

The Report pane has three Tabs:

- **Data**: For editing the query for the Report. Look at the appendix in this document to see a more complex Report query example, using the graphical query builder instead of the wizard.
- **Layout**: For visually designing the Report with drag and drop functionality.
- **Preview**: For viewing the finished report with real data.

The ‘Properties’ panel on the right is used for setting fonts, color, and other visual properties. The ‘Fields’ panel on the left is used to drag database fields onto the report. The ‘Toolbox’ panel also on the left is for dragging Report controls onto the Report layout. This is how you can add tables, labels, images, and charts to the Report layout.

**Note:**

Use the View → Fields menu, pick to open the Fields panel when in Layout mode.
Use the View → Toolbox menu, pick to open the Toolbox panel.
To open the Header and Footer, right-click to open the context menu in the pink field in the Report layout.
5.10 Deploying the Report

Once you are satisfied with the Report query and layout as viewed from the Preview Tab you need to deploy the Report to the Reporting Service. From the ‘Solution Explorer’ panel right mouse click on the ‘User Directory’ Report item and select the context menu choice Deploy. Watch for error messages in the output window at the bottom of the frame.

5.11 Confirm Deployment

To confirm the new report has been deployed, open IE Browser and navigate to http://localhost:80/Reports. You should see the ‘Innovator Reports’ folder. Click on that link and you should see the report you created.

Select the hyperlink for the new Report and after it opens, run the Report.
5.12 Running the Report from within Aras Innovator

In order for users to run the new Reporting Services Report from within Aras Innovator you need to create an Innovator Report Item. The important settings to enable the Innovator/Reporting Services interface are:

- The Innovator Report Item name must be exactly the same as the Reporting Services Report name.
- The Location Field choice must be set to the new ‘Service’ option.
- The Report Query Field specifies the parameters that are passed to the Report Server.

5.12.1 Adding Aras Innovator Report Item

1. Log into Aras Innovator as administrator.
2. In the Navigation pane, navigate to Administration --> Reports. The following menu appears:

   ![Figure 38.](image)

3. Click Create New Report. A blank Report form appears:

   ![Figure 39.](image)

4. Enter the name of the Report (again this is the name you specified when you created the Report in Visual Studio).
5. Select the Report Type, which in this case is ‘Generic’ meaning this Report, is available always.
6. Select the Report Location, which in this case is ‘Service’.
7. Select the Report Target, which in the case we want ‘Window’.
8. Because this sample Report is of type ItemType there is no Report query Value.

**Note:** If you are using Firefox, you have to manually enter a stylesheet under the **Stylesheet** tab.

9. Test the Report by clicking on the Reports main menu bar choice and you should see the new ‘User Report’ choice. Click on the menu choice and you should see a new window open with the ‘User Directory’ Report.

### 5.12.2 Passing Named Parameters to the ReportServer

As step 4 describes in the section 3.1, Report Server Variable, the value of the Innovator Report Item Property report_query is appended to the ReportServer URL providing additional parameters to control the ReportServer.

For example, the ID of the Item can be passed as the Named Parameter @ID for the SQL Select for the Reporting Services Report as in this example:

```
SELECT * FROM [PROJECT] WHERE id=@ID
```

To pass the ID for the context Item (the selected Item) on the URL to the ReportServer, the Innovator Report Item report_query Property would look like this:

```
np:id=<xsl:value-of select="@id"/>
```

This is actually an XSLT stylesheet fragment and is the directive for Innovator to add the string &id=ACBDEF0123456789ACBDEF0123456789 to the end of the ReportServer URL (but the actual ID value is used).

In this case the Innovator Report is of type Generic so no ID is required but perhaps we want the Reporting Services Report to be returned in PDF or Excel format. We can control the ReportServer by adding the following parameter as the report_query value for the ‘User Directory’ Report:

```
rs:Format=PDF
```

![Figure 40.](image-url)
Note: If you need to include more than one parameter for the report_query value, you need to use the Entity & rather than the actual & symbol to delimit the parameters. Recall that the report_query value is eventually part of the query_string for the URL to the ReportServer but is actually an XSLT stylesheet fragment and so the special symbols like <, >, and & need to be protected in XML need to be entered as Entities &lt; &gt; and & respectively.

For example, to pass the Named Parameter ID and also the Format PDF in the same report_query the value would look like this:

np:id=<xsl:value-of select="@id"/>&rs:Format=PDF
6 Report Server query_string Parameters

There are several parameters that you can use to control how the Reporting Services run your Report requests. You include these in the Innovator Report Item's report_query property, which the client then uses to form the query_string for the ReportServer request:

6.1 Named Parameters

Named Parameters passed onto the SQL Select query. For example,

```
np:last_name=Kohl
```

Would map the value Kohl to the Named Parameter @last_name in the SQL Select:

```
SELECT * FROM [USER] WHERE last_name=@last_name
```

6.2 Format Parameter

Format parameter to control the format the Report is rendered:

```
rs:Format=XML
rs:Format=PDF
rs:Format=HTML4.0
rs:Format=MHTML
rs:Format=EXCEL
rs:Format=Word
```

6.3 Zoom

Control the zoom:

```
rc:Zoom=100
rc:Zoom=% zoom as integer
rc:Zoom=Page Width
rc:Zoom=Whole Page
```

6.4 Reports Folder

The default Folder where Reporting Services Reports are deployed is in 'Innovator Reports' however, you may deploy the Reports in other Folders and you specify this using this Parameter:

```
irs:Folder=Your Folder Name
```

6.5 Report Name

The Aras Innovator client automatically appends the Parameter to specify the Report to run on the query_string, which is the name of the Innovator Report Item. However, if you run reports programmatically you may need to set this directly yourself:

```
irs:Report=Your Report Name
```
7 Report Manager

The Reporting Services ReportServer comes with a Report Manager page to administer the Reports, Folders, Data Sources, and so on. This page has been integrated into Aras Innovator client via an Innovator Report that opens the Report Manager page (see section 2 Configuring Aras Innovator for more information about this Report Item).

Reports that are created and tested on the development machine can be moved to a production ReportServer by exporting the RDL file for the Report from your local development machine and then importing it into the production machine.

The process of exporting a Report and importing it into another ReportServer and enabling the Report in Aras Innovator is a four step process:

1. Export the RDL file via the Report Manager page.
2. Import the RDL file via the Report Manager page.
3. Reassign the Data Source to the imported Report.

7.1 Opening the Report Manager page

1. In the TOC, navigate to Administration → Reports.
2. Click Reports on the main menu and the ‘Report Manager’ choice.
3. The Report Manager page opens in a new window as shown here:

![Figure 41](image)

**Note:** This same page can be opened from your browser with the URL [http://localhost:80/Reports](http://localhost:80/Reports)
7.2 Export the RDL

To export a RDL file for a Report, click on the ‘Innovator Reports’ Folder. You see a list of Reports and Shared Data Sources.
Select ‘Manage’ from the Report Context menu, and then select ‘Download’ from the User Report page. This opens a dialog asking for confirmation that you want to save the RDL file.

Figure 42.
7.3 Import the RDL

Log into the target Aras Innovator Server:
1. In the TOC, navigate to Administration ➔ Reports.
2. Click Reports on the main menu and the ‘Report Manager’ choice.
3. The Report Manager page opens in a new window as shown below:

Note: This same page can be opened from your browser with the URL http://localhost:80/Reports

Figure 43.

Figure 44.
Click on the 'Innovator Reports' Folder and you see a list of Reports and Shared Data Sources. Click 'Upload' in the middle of the screen.

Figure 45.
This opens the File Selection dialog for you to select the RDL file to upload. Select the RDL file and click **Open**. The RDL file is uploaded to the target ReportServer and deployed. You should see the new Report in the Folder now.
7.4 Select the Shared Data Source

The Data Source for the Report may need to be changed if the name of the Shared Data Source is different on the target ReportServer. Select ‘Manage’ from the Report Context menu; this opens the Properties page for the Report where you can select its Shared Data Source.

![Edit User Report](image)

Select the ‘Data Sources’ navigation link. The first choice ‘A shared data source’ should be selected.

![Edit User Report](image)

If the named Shared Data Source is incorrect for this ReportServer click ‘…’ to open the Shared Data Source page. Navigate the Folders to locate the desired Shared Data Source, select it, and click ‘OK’. 
Figure 49.
8 Date Related SQL Queries

AML is the language of Aras Innovator, but some external add-ons do connect to Aras Innovator on a direct SQL level. Because Aras Innovator stores DateTimes in SQL Server as UTC, we have provided an add-on function for Microsoft SQL Server that allows the easy conversion of DateTime to and from UTC. To convert DateTime values from UTC to a specific time zone, use the function ConvertToLocal ((value),(Time Zone)). The time zone should be specified according to the registry key name of the time zone desired. (Refer to Aras Innovator - Configuring Internationalization) To use the DEFAULT parameter for the {Time Zone}, it is required that a value be set for CorporateTimeZone.

Example:
```sql
select item_number, created_on
from innovator.Document
```
Would be written as
```sql
select item_number, innovator.ConvertToLocal(created_on,DEFAULT) as CreatedOn
from innovator.Document
```
Or
```sql
select item_number, innovator.ConvertToLocal(created_on,'Eastern Standard Time') as CreatedOn
from innovator.Document
```
To convert DateTime values from a specific time zone to UTC, use the function ConvertFromLocal((value),(Time Zone)). The time zone should be specified according to the registry key name of the time zone desired. (Refer to Aras Innovator - Configuring Internationalization) To use the DEFAULT parameter for {Time Zone}, it is required that a value be set for CorporateTimeZone.

Example:
```sql
update innovator.Document
set effective_date = '1/1/2007 00:00:00.00'
```
Would be written as
```sql
update innovator.Document
set effective_date = innovator.ConvertFromLocal('1/1/2007 00:00:00.00',DEFAULT)
```
Or
```sql
update innovator.Document
set effective_date = innovator.ConvertFromLocal('1/1/2007 00:00:00.00','Eastern Standard Time')
```
This allows users to write queries in a familiar time zone context.
```sql
select item_number, innovator.ConvertToLocal(release_date,DEFAULT) as ReleaseDate
from innovator.Document
where created_on >= innovator.ConvertFromLocal('1/1/2007 00:00:00.00',DEFAULT)
```